
Huntron Diagnostic Systems
Flexible, automated diagnostic solutions to help people 
solve circuit card problems

ProTrack
ProTrack Scanner

TrackerPXI
Access Automated Probing Station

Huntron Workstation software

As density and complexity increase, printed circuit 
assemblies become tougher to probe and test.

Huntron complements conventional test equipment with 
access and test tools that catch the elusive problems 
other methods often miss.

The keys are physical and virtual access, which trans-
lates into meaningful results such as shorter design 
cycles, improved production yield and lower 
warranty costs.

When you need to test, diagnose or troubleshoot 
complex circuit boards, Huntron lets you 
access, explore and discover more.

Huntron ProTrack Scanner 1 Specs
Provided by www.AAATesters.com
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PCA Troubleshooting for Manufacturing, Rework 
and Service
Since 1976, Huntron has been developing a range of test instrumentation specifically designed for compo-
nent level troubleshooting on PCAs (printed circuit assemblies) in rework, repair, and remanufacturing. The 
Huntron® Tracker® utilizes the power-off testing methodology of Tracker Signature Analysis. The development 
of the Huntron ProTrack® I has taken power-off troubleshooting to a much higher level. 

Huntron® Tracker® Signature Analysis 

A current-limited AC signal is applied across two 
points of an electronic component or circuit. The 
resulting current/voltage waveform is presented 
on a display using vertical deflection for current 
and horizontal deflection for voltage providing 
a unique signature that represents the overall 
“health” of the DUT (device under test).

Basic Tracker Signatures

Tracker signatures can be categorized based on the four basic component types. These signatures are resis-
tive, capacitive, inductive and semiconductive signatures. All signatures will exhibit at least one of these 
characteristics but more often include combinations that are referred to as composite signatures.

The Benefits of Power Off Testing

• Troubleshoot circuitry that cannot be powered due to a catastrophic failure

• Test without the risk of accidental shorting that could cause further damage

• Work effectively on PCAs with mixed technology, i.e. digital and analog components

• Perform preventative diagnosis by seeing component flaws that could lead to premature failures

1. Resistive signatures 
have a linear response 
with the angle of the 
trace determined by the 
value of resistance.

2. Capacitive signa-
tures have an elliptical 
response with the width 
of the trace determined 
by the value of capaci-
tance.

3. Inductive signatures 
have an elliptical re-
sponse. The trace width 
is determined by the 
value and the angle by 
component resistance. 
Inductors often exhibit a 
distorted shape.

4. Semiconductive 
signatures show the 
conducting and non-
conducting states. 
Approximate break-
down voltages can be 
determined using the 
horizontal graticule.

The combination of voltage (Vs), resistance (Rs) and frequency (Fs) 
form the basis for a Huntron Tracker test range
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Looking for Differences

Troubleshooting with Tracker signatures is possible without 
the use of documentation or known good circuit boards. 
This is accomplished by searching for patterns in the signa-
tures that are displayed on like pins of a component or bus. 

An example would be to compare all of the input pins on an 
inverter IC with each other and compare all of the output 
pins of the inverter with each other looking for variances 
in the signature patterns. The input and output pins should 
compare favorably with similar pins. Any deviations in the 
pattern could indicate a real problem. This same technique 
can be applied to address and data bus lines and circuit 
boards that have duplicated circuitry such as multi-channel 
boards.

The Benefits of Tracker Signature Analysis

• Troubleshoot without the use of documentation or a known good board

• Quickly locate problems with digital IC protection circuitry by comparing similar pins  

• Effectively search for component failures regardless of the overall board function

Getting Down to Basics

Comparing Tracker signatures can be accomplished manually or with the aid of a computer for signature 
storage using the Huntron Workstation software. All Huntron Trackers utilize dual channel interfaces for easy 
side-by-side comparison of good versus suspect circuit boards. Using this comparison method, suspect 
components can be quickly identified.

All ProTrack systems come with the Huntron Workstation software thus eliminating the need to have a known 
good reference board available for comparison. Signature comparisons are made automatically with the failed 
signatures displayed for interpretation.

The curved portion of the zener diode signature on 
the right indicates slow biasing 

This signature comparison shows the diode on the 
right conducting at the wrong voltage

The signature of the capacitor on the right is 
showing resistance indicating current leakage

These signatures from good and bad comparator 
ICs show that damaged PN junctions are easily 
recognizable
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The Value of Variable Test Ranges (V + R + F)

Three variables make up a Tracker test range: voltage (V), internal Tracker resistance (R) and AC sinewave 
frequency (F). By adjusting any of these three variables, either individually or in combination, characteristics 
of the Tracker signature can changed. The examples below show a simple circuit made up of a diode, resistor 
and capacitor in parallel. Note how the Tracker range parameters are varied to bring different aspects of the 
signature into focus.

Voltage: 15V
Resistance: 10KΩ
Frequency: 100Hz
Effects from all of the 
components are shown in 
the signature shape

Voltage: 200mV
Resistance: 10KΩ
Frequency: 200Hz
Using a voltage below 
600mV eliminates the diode 
from the signature

Voltage: 15V
Resistance: 10KΩ
Frequency: 20Hz
By changing frequency, only 
the diode and resistor affect 
the signature shape

Voltage: 200mV
Resistance: 10KΩ
Frequency: 20Hz
Adjusting the frequency 
reduces the capacitive 
effect in the signature

Voltage: 10V
Resistance: 100Ω
Frequency: 60Hz
Changing the resistance 
removes the resistive effect 
from the signature

Voltage: 200mV
Resistance: 1KΩ
Frequency: 5KHz
Changing the resistance 
reduces the effect of the 
resistor in the signature

The Huntron ProTrack I

The Huntron ProTrack I enables the user to set the applied voltage, frequency and source resistance to best 
match the circuit characteristics and display the optimum Tracker signature. Connecting to a personal com-
puter will allow for creation of complete test routines and signature storage.

The creation of ProTrack 
test ranges involves select-
ing a voltage initially based 
on the component source 
voltage. Resistance is 
selected based on circuit 
impedance. Frequency is set 
depending on the presence 
and value of reactive compo-
nents. The goal is to achieve 
an even ratio of horizontal 
versus vertical signature 
deflection.

Component values:
Zener Diode: 5.1V
Resistor: 10KΩ
Capacitor: .047µF

The Huntron ProTrack I

Huntron ProTrack I Features
• CRT with graticule overlay
• LCD for range and menu display
 with menu selection buttons
• Encoder for range and menu selection 
 and control
• A and B channel connections with  
 channel selection controls
• Built-in Pulse Generator for biasing  
 switched devices
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Huntron ProTrack Scanner

The Huntron ProTrack Scanner accessory allows the testing of com-
ponents using standard IC clips and cables. This combination allows 
for faster testing by scanning up to 128 pins.

The ProTrack Scanner consists of two 64 pin channels with IDC 
headers for cable connections and ZIF (zero-insertion force) sockets 
for testing discrete ICs. The ProTrack I and ProTrack Scanner combi-
nation can be used as a stand-alone system to make quick compari-
sons between two PCAs. When connected to a personal computer 
running Huntron Workstation software, the ProTrack I and Scanner 
can scan and store component signatures for later reference when 
testing suspect boards.

Using the Huntron ProTrack Pulse Generator

The Huntron ProTrack I has a built-in pulse generator for triggering gate-fired devices such as SCRs (silicon 
controlled rectifiers), TRIACs, optocouplers and relays. By driving the control input of the device under test 
while using the ProTrack I to monitor the signature of the outputs, a dynamic test of the component can be 
performed. Gate-fired components can effectively be turned on and off to check their functionality.

The gate output of the pulse generator is connect-
ed to the gate of the device. The device output 
terminals are connected to the ProTrack I test 
and common leads. The pulse generator voltage 
is then increased until the device turns on. The 
example below shows the off and on state of a 
common SCR.

The pulse generator can apply either a DC voltage or 
a pulsed square wave to the gate-fired device. The 
amplitude is variable and can be controlled manually 
or using the Huntron Workstation software.

The Benefits of the ProTrack Scanner

• Connect to PCA connectors for a quick “first pass” test

• The standard IDC headers simplify connecting to external fixtures such as a bed-of-nails  

• Screen ICs in the ZIF socket prior to PCA insertion

The OFF state of the SCR shows 
an open signature

The ON state of the SCR shows 
a diode signature as the device is 
triggered

Huntron ProTrack with the 
ProTrack Scanner accessory
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Huntron TrackerPXI

Integrate a Huntron Tracker into your PXI based test System

The Huntron TrackerPXI is designed to add component level 
diagnostics to your existing PXI test platform. Take advantage 
of ProTrack style signature analysis capabilities to help you 
troubleshoot printed circuit board (PCB) faults to the compo-
nent level. Reduce potential damage by using power-off test 
prior to powering a PCB. Support existing test systems by 
further reducing the size of component ambiguity groups. 

The Huntron TrackerPXI is controlled using the Huntron 
Workstation Software for test database creation and signature 
capture. Signatures from known good PCBs are stored in the 
test database and used for comparison when troubleshooting 
suspect PCBs. The TrackerPXI has the same range capabili-
ties as the Huntron ProTrack so tests created using either 
platform are interchangeable.

Interfacing the Huntron TrackerPXI to test points can be accomplished manually using Huntron Microprobes 
or automatically when used with a Huntron Robotic Prober such as the Huntron Access Automated Probing 
Station. Connections are made using standard shrouded banana plugs or BNC connectors. The auxiliary 
connection breaks out additional lines such as Trigger IN, Trigger OUT, Signal ON, Line IN and Line OUT for 
added test control.

The Benefits of the Huntron TrackerPXI

• Add Huntron Tracker power-off testing capabilities to existing PXI-based test applications

• Interface to PCB test points manually or using a Robotic Prober  

• Control using the Huntron Workstation Software

Huntron TrackerPXI

Huntron TrackerPXI Specifications

Electrical
Open Circuit Voltage (Vs: 24 selections of peak voltage):
 200mV, 400mV, 600mV, 800mV
 1V to 20V in 1V steps
 including 10V (Low), 15V (Med 1), 20V (Med 2)

Source Resistance (Rs: 16 selections of resistance):
 10Ω, 20Ω, 50Ω, 100Ω, 200Ω, 500Ω, 1kΩ, 2kΩ, 5kΩ, 10kΩ, 20kΩ,
 50kΩ, 100kΩ, 54Ω (Low), 1.2kΩ (Med 1), 26.7kΩ (Med 2)
Maximum Current: 200 mApk (Vs/Rs; short circuit current)

Frequency (Fs: 40 selections of frequency):
 20Hz to 190Hz in 10Hz steps
 200Hz to 1.9kHz in 100Hz steps
 2kHz to 5kHz in 1kHz steps

Channels
 Number   1
 Overvoltage Protection  Circuit breaker

Connections
 Signal  1 BNC; 1 shrouded banana  
 Common  1 BNC; 1 shrouded banana
 AUX   9 pin mini jack

GENERAL
Dimensions  6.3” W x 3.9” H   
    (16cm W x 10cm H)

Platform   PXI/Compact PCI 3u slot

Warranty   1 year limited
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Huntron Robotic Probers

Huntron offers Robotic Probers for use in automated test development. Automatic probing has been demon-
strated to significantly reduce test times over manual test methods. 
No expensive fixtures are required and most complex SMT devices can be accessed. Huntron Probers act as 
a universal fixture and, because of itʼs fast time to test, can be used in first article test applications before the 
permanent fixture is built.

The Benefits of Huntron Robotic Probers

• Interface to components down to sub 20 mils (0.020”) lead spacing

• Significantly decrease test development and run times compared to manual methods

• Standard BNC connectors enable the use of external test equipment such as oscilloscopes  

• Extend the testing capabilities by combining with a Huntron ProTrack Scanner for interfacing 
 to additional common reference points, i.e. bed-of-nails, PCA connectors

Robotic Probers utilize a built-in color camera system to target component 
pins for testing. Component positions are referenced to alignment points 
selected at the beginning of the test creation. Teaching package types such 
as dual-inline, single-inline, quad and multi-row is made easy by targeting on-
screen cross hairs on component pins or pads. Key points on the component 
such as the first and last pins of each row are used to quickly locate and teach 
the remaining pins. Utilizing optional CAD tools allows you to import CAD data 
to quickly create base tests including component information and XY pin locations. Using CAD data for test 
creation can save up to eighty percent in test development time.

Components can be scanned individually or by test sequence. The component signatures are stored for com-
parison for use when scanning suspect circuit boards.

Huntron Access Automated  
Probing Station

Laser encoding on the X and 
Y axes ensures precise 20 
micron accuracy and 10 micron 
movement resolution.

Standard bed-of-nails 
style test probes can 
easily be interchanged 
depending on your 
application.

High resolution color 
camera provides 
a clear view of the 
PCA for optimal test 
point positioning. 
The camera is used 
for PCA alignment 
and teaching XY pin 
positions.  

Circuit boards are 
mounted at one of three 
slot levels using standard 
mounting accessories or 
custom board holders. 
The bottom plate can be 
removed for access from 
underneath.
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Huntron Hardware Specifications

ProTrack I Model 20

Electrical
Open Circuit Voltage (Vs: 24 selections of peak voltage):
 200mV, 400mV, 600mV, 800mV
 1V to 20V in 1V steps
 including 10V (Low), 15V (Med 1), 20V (Med 2)
Source Resistance (Rs: 16 selections of resistance):
 10Ω, 20Ω, 50Ω, 100Ω, 200Ω, 500Ω, 1kΩ, 2kΩ, 5kΩ, 10kΩ, 20kΩ,
 50kΩ, 100kΩ, 54Ω (Low), 1.2kΩ (Med 1), 26.7kΩ (Med 2)
Maximum Current: 200 mApk (Vs/Rs; short circuit current)
Frequency (Fs: 40 selections of frequency):
 20Hz to 190Hz in 10Hz steps
 200Hz to 1.9kHz in 100Hz steps
 2kHz to 5kHz in 1kHz steps
Channels
 Number   2
 Display modes   A, B, Alt, A+B
 Overvoltage Protection  Circuit breaker

Pulse Generator
 Level   0 to ±10V
 Width (pulse mode) 2% to 50% duty cycle
 Source resistance 100Ω
 Maximum current 100mA max.
Displays
 CRT   monochrome, 2.8" (7cm) diagonal
 LCD   full graphic, 128 x 64 pixels
Power Requirements
 Line Voltage/Freq. 100VAC to 250VAC / 47Hz to 63Hz
 Power  35W

GENERAL
Dimensions  11.6” W x 4.5” H x 15” D
    (30cm W x 11.5cm H x 38cm D)
Weight   10 lbs. (4.5kg)

Warranty   All ProTrack products, 
    1 year limited

ProTrack Scanner I

Electrical
Channels
 Number   2
Pins
 Test    64 per channel
 Common   64 per channel
Connectors
 IDC    64 pins each channel
 ZIF    40 pins each channel

Power Requirements
 Line Voltage  100VAC to 240VAC
 Frequency  47Hz to 63Hz
 Power  10W

GENERAL
Dimensions  12” W x 3” H x 19.5” D
    (30.5cm W x 7.6cm H x   
    49.5cm D)
Weight   5 lbs. 8 oz. (2.5kg)

Warranty   1 year limited

Huntron Access Prober

Maximum Board-Under-Test Size 19.4” x 14” (49.3cm x 35.6cm)

Maximum Board-Probing Area 15.3” x 12.9” (38.9cm x 32.6cm)
 
Maximum Allowable Component
Height on Board Under Test 2.375” (6.03cm)
      
Minimum Probe Speed  4 inches/second (10cm/second)

Accuracy   ±0.0007874” (±20 microns)
     
Minimum Step Resolution 
(using Huntron Workstation) 0.0003937” (10 microns) 
 
Maximum Z Travel  2.21” (5.6cm)

Linear encoder resolution 0.0003937” (10µm)

Vision System  Color CCD 811 x 508 pixels

Light Source  Adjustable white LED array

Camera card  High resolution frame grabber  
    754x480 pixel max. resolution

Lens System  25mm C-mount; adjustable

Camera Adjustments  Manual focus, manual aperture

Power Requirements
 Line Voltage  115VAC or 230VAC; 50/60 Hz
 Power  100W

Dimensions  26.5” W x 13” H x 24.5” D
    (67.3cm W x 33cm H x 62.3cm D)

Weight   63 lbs. (28.6kg)

Warranty   1 year limited

Minimum PC Specifications for Huntron Workstation Software
• PC with 1Ghz or faster processor • CDROM or DVD drive
• Microsoft Windows 2000 or XP (XP required for CAD tools) • Keyboard and mouse
• 512MB RAM or higher • Available USB port (for ProTrack)
• 1GB available hard drive space • Available PCI slot (for Prober Frame Grabber card)
• 800x600 video resolution with 16bit or higher color • Available serial port (for Huntron Prober)



Huntron Diagnostic Systems           Huntron, Inc.         www.huntron.com 

Huntron Workstation Software

The Huntron Workstation Software is designed to bring a high level of efficiency and flexibility 
to board test creation and troubleshooting. The multiple pane layout of Huntron Workstation al-
lows for fast test creation, quick viewing of component signatures, control of robotic probers and 
CAD viewing tools that update on the fly.

Huntron Workstation Features

• Create custom test routines for low volume manufacturing, repair and rework applications

• Support of optional utilities for test creation using PCB CAD data

• Easily create, modify and save Microsoft Access based test databases

• View, print and store test results immediately

• Interactive application panes automatically update as selections are made

• Includes an easy to use Test Only pane better suited to test execution in a production environment

Tree pane: Using a spreadsheet style format, the 
creation of test sequences is quick and easy. Fine tune 
component test parameters to the pin/range level and 
combine components into custom test sequences.

Prober pane: Selecting tools for robotic prober control 
is as easy as clicking the appropriate tab. Features 
include PCB alignment, test point location and 
automated panelization tools.

Image pane: View linked CAD data, board image and 
stored XY data points. Create an image of the entire 
PCB and use it to navigate with a Robotic Prober.

Signature pane: Configure the signature scale to 
display several columns of signatures at one time. 
Multiple signature scans can be stored and viewed 
simultaneously at any time. 
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• Create as many Test Sequences as needed based on board side, a specific set components or a user-  
 defined test set
• Quickly edit Sequence, Component, Pin and Range parameters in a familiar spreadsheet style layout
• Configure important Component parameters such as type and pin spacing
• Fine tune Component Pin settings including Pulse Generator control, channel selection and enable or   
 disable scanning of the pin
• Manage all Scans performed and configure which scans are used for signature comparison
• Application panes will automatically update to reflect selections made in the Tree pane

• View and save multiple component signature scans to help eliminate false failures caused by differences  
 in component manufacturers
• Observe the test signatures during scanning along with start time, elapsed time, estimated finish time   
 and a Component/Net counter
• PASS or FAILED test results are clearly displayed at the conclusion of a test sequence scan
• View, print and edit the Troublesheet signatures or add signatures as stored test reference
• Control the ProTrack or TrackerPXI hardware in realtime and Preview signatures when selecting ranges

Huntron Workstation Software 
Test Creation using the Tree Pane

Hardware Control and Signature Storage using the Signature Pane

The Sequences tab of the Tree Pane is where test 
sequences are created, selected and edited.

The Ranges tab of the Tree Pane is where component test 
ranges (voltage, resistance and frequency) are created, 
selected and edited.

The Scan tab of the Signature Pane displays signatures 
during scanning and the test results.

The Troublesheet tab of the Signature Pane displays the 
signatures of a failed test sequence.
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• Control Prober functions such as Camera Offset, Alignment and Teach from one pane
• Select Prober movement units in inches, mils, millimeters or microns
• Teach mode allows for easy selection, editing and correction of XY test locations  
• Component XY pin positions are set by teaching groups of pins based on their row arrangement
• Easily reassign alignment points using the functions in the Realign tab 
• Create multiple panel tests by creating a test for one panel and duplicating the test with an offset 
 distance from the original

• View PCB CAD layout images including layer and board side selection
• Select component pins or net points to display net name and connected component net points
• Use the Image tab features to create a mosaic image of the PCB and clicking a point in the image will   
 drive the Prober to that area
• View test point information in the View PCB tab and save the image for use in other programs
• View picture files in many formats using features in the File tab 

Huntron Workstation Software
Robotic Prober Control using the Prober Pane 

Image Control using the Image Pane

The Teach tab of the Prober Pane is used when teaching 
component XY locations to be scanned.

The Panelize tab of the Prober Pane allows for setting 
multiple panels based on the location of the first panel. 
Component XY information is carried over to the new panels. 

The Image tab of the Image Pane displays a mosaic image 
captured by the Proberʼs built-in color camera. The View PCB tab of the Image Pane shows the alignment 

points and all points that could be tested for the selected 
test sequence.
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Customer Services
Huntron staff and representatives are available throughout the pre-sale and post-sale processes of your test 
equipment purchase. We are ready to assist in the selection process including cost justification, the design pro-
cess including test program generation, and the installation process including operator training and fine tuning of 
test procedures. 

Service and Support

Huntron products are supported worldwide through our network of sales and 
service facilities.
Whether it is sales questions, hardware repair or technical support, we are 
ready to get you up and running with a minimum of delay.

Training

Send your technicians to Huntronʼs in-house training facility near Seattle, WA, 
for an intensive three day program. Our lab is equipped with a full compliment 
of Huntron ProTrack products allowing each student the maximum hands-on opportunity. Attendees are required 
to bring typical circuit boards they are responsible for testing. This allows them to develop test routines and come 
away with solutions they can apply immediately. 

Test Program Generation

Huntron offers custom test programming services to develop base line programs for your printed circuit assem-
blies. Our Technical Support personnel have many years of troubleshooting experience in real world applications 
and will provide a good starting point for your test program. All you will need to do is the final adjustments to cus-
tomize the procedure, thus significantly reducing your test development times.

Contact our Technical Support group at 1-800-426-9265 for more details regarding our programming and training 
services or visit our web site at www.huntron.com.

Huntron products are available worldwide through our network of Representatives. For the name of the Sales Of-
fice near you, call 1-800-426-9265 or visit our web site at www.huntron.com.

Represented by:


